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What Is On-Campus Recruitment (OCR) and Who Is Eligible? 
 
Class of 2009: From September 17, 2008 through April 2009, employers visit The Career Center at Suite 200 
of the North Decatur Building, to interview graduating students for full-time, entry-level positions. To participate 
you must be a December 2008 or May 2009 graduate from a Bachelor’s, Master’s, or Doctorate program (MBA 
students are ineligible to utilize OCR). 
 
Class of 2010: From September 17, 2008 through April 2009, employers visit The Career Center at Suite 200 
of the North Decatur Building, to interview current students for internship positions. To participate you must be 
a December 2009 or May 2010 graduate from a Bachelor’s, Master’s, or Doctorate program (MBA students are 
ineligible to utilize OCR). 
 
Class of 2009 & 2010: You must review The Career Center Policies & Procedures to participate in the 2008-
2009 recruiting calendar. You can review this at http://www.career.emory.edu/students/policies.html.  
 
 
What Is Eagle Ops? 
 
Eagle Ops is Emory's on-line career management system helping students connect with hiring organizations 
for a wide variety of employment opportunities. The Career Center’s On Campus Interviewing (OCI) program is 
also managed through this site, as well as a calendar feature that includes the most current information on 
upcoming career related programs and events. You must be a current Emory student to be able to access 
Eagle Ops.  You can access the system 24 hours a day to: 
 

• Store your resumes and other job search documents 
• Search for jobs 
• Apply for jobs 
• Sign up for an interview online 
• Track your job search, including job listings and resume submissions 
• Search for on campus company presentations 
• RSVP for on campus company presentations 

 
In addition, you can also use Eagle Ops to view all upcoming programs and workshops sponsored by The 
Career Center. 
 
 
Accessing Eagle Ops 
 
First Time Users: 

1. Go to https://emory-csm.symplicity.com/students/ or visit our web site at www.career.emory.edu and 
click on the Eagle Ops Login link. 

2. Enter your 7 digit Emory ID number as your username and emory (in lowercase) as your password. 
3. Follow the prompts to complete your profile. 

 
 
Returning Users: 

Eagle Ops On-Campus Interviewing Student User Guide
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1. Go to https://emory-csm.symplicity.com/students/ or visit our web site at www.career.emory.edu and 
click on the Eagle Ops Login link. 

2. Log in with your username (7 digit Emory ID number) and password. 
 
 
Using Eagle Ops 
 

Once you login, you will be redirected to your Eagle Ops homepage, containing a Navigation Toolbar, Quick 
Links, Announcements and Alerts.  The navigation toolbar and quick links contain the tools and features 
necessary for you to view and sign-up for OCR interviews, view employer presentations, track your 
applications, and upload your documents.  
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Uploading Your Resume 
 

1. Select Documents from the navigation bar at the top of the page. 
2. Click Add New to enter a new resume. Use a previously created and saved resume to complete this 

process. 
 

 
3. Insert a label (i.e. “John Doe”) for your resume. Remember to name the resumes appropriately since 

the company will see the name when they log into their account. 
4. Click Browse to search for your resume from a your hard drive, disk or flash drive.  
5. Click Submit. 
6. At this point you will be able to preview your resume by clicking on the resume title.   

 
NOTE:  Employers select students for interviews using the name exactly as it appears on the documents they 
have received (resume, transcript).  These names are matched with the Eagle Ops system, so be sure the 
name on your documents is identical to the name you used to register for Eagle Ops. 
 
 
Resume Formatting Tips 
 
As with any document transmitted over the Internet, minor formatting errors may occur.  Eagle Ops uses PDF 
technology.   

 It is recommended that you use common fonts such as Times Roman or Arial to ensure that resumes 
print correctly for all employers. Font effects such as outlines and shadows may cause even simple 
fonts to convert improperly. 

 
 One-inch margins are recommended. If your original document has small margins, the conversion 

might cause words to wrap and throw off the formatting.   
 

 Use left-justification instead of full-justification which can also affect the formatting of your resume. 
 

 Avoid the three Ts: Templates, Text boxes, or Tables in your resume since they may not display 
correctly.  To preview a resume to ensure proper formatting click on the resume title in “Documents.” 

 
 If you see unintentional symbols in your preview, it may be that you need to try a new font. Change the 

font in your original document, and then re-save and re-upload the file. This is also true if you use 
certain bullets in your resume. 

 
 If when you upload your resume, the first page is blank it may be a formatting issue in Microsoft Word 

so try these two options: 
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o Open up your resume in Word and Go to File > Page Setup. Click on the Layout tab. Make sure 
Section Start is set at New Page or Continuous. Click on the OK button. 

 
 If that does not work then: 

 
o Go to Insert > Page Numbers. Click on the Format button. Make sure the Page Numbering is 

set at Continue from Previous Section or Start at Page 1. Click the OK button. On the Page 
Numbers window, uncheck the box that reads, "Show number on first page." Click on the OK 
button 

 
 
Cover Letters and Transcripts 
 
Cover letters and transcripts can be uploaded to Documents by following the instructions for uploading your 
resume. Unless requested in the job description, cover letters are NOT necessary for Eagle Ops electronic 
submissions.  
 
Some organizations will want you to supply an unofficial transcript before scheduling an interview so they can 
review your academic background. If a transcript is requested, follow the same procedure that you use to 
submit your resume. First make a copy of your unofficial transcript. You can copy your unofficial transcript from 
OPUS and save it as a Word document on your computer. After you save your transcript as a file, simply 
upload it to the Documents link in your Eagle Ops record by selecting “Unofficial Transcript” under Document 
Type.  If an employer has requested your transcript, you must include it when you submit your resume. 
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Searching for OCR Jobs 
 

1. Click Jobs, and then click Eagle Opportunities Jobs.     
2. Click All OCR Interviews under Show Me.  To maximize your search results, leave all search options 

open. 
 

 
3. Click Perform Search.  

 
 
Applying to Jobs 
 

1. Click on the Job Title to view information on: 
• Organization 
• Qualifications 
• Position description 
• Contact information 
• Interview date 
• Timeline for submission and interview sign up 
• Requirements for submission (resume, transcript) 

2. Apply by selecting your resume (as well as any additional documents required to apply for the position) 
from the drop down menu and clicking “Submit” during the resume submission period.  These dates 
may be found under “Schedule Details” on the right hand side.   

3. Select the resume and additional required documents you wish to send and click Submit. 
 
NOTE: The ability to see and sign up for on-campus interviews is tied to your qualifications and submission 
deadlines.  If your degree, major, cumulative GPA or work authorization does not match the requirements for 
an on-campus interview, you will not be able to apply for the position through the system.   
 
***To check your education information and Work Authorization, click Profile in the navigation toolbar.  
Please note that even US Citizens must select a "Visa Type".    
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Viewing Application History 
 
This feature lets you keep track of all jobs you have applied to and all the on-campus interview opportunities 
you have signed up for through Eagle Ops.  It is important to check this regularly because it will let you know 
the status of all your applications.   
 

1. Click on Interviews in the navigation toolbar at the top of the screen. 
2. Click on Scheduled Interviews to view positions that you have been selected to interview for or 

Interview Requests to view your interview status. 
3. The status of your application will be announced under each position. 
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Withdrawing or Changing a Resume After Submission to an Employer 
 
You can view your resume submissions under Interviews.  If the submission deadline has NOT passed, you 
may edit your resume.  To do so, click the Withdraw Application button and reapply with a new version of your 
resume.  If you edit the version that was submitted, the system will automatically update the document in ALL 
of your active applications. However, if the submission deadline HAS passed your resume cannot be updated. 
 
Signing Up for Interviews 
 
If selected for an interview you will receive an email about your status as a preselect candidate or an alternate 
in addition to the sign up dates.  A link is included in this email to direct you to the sign up page.  Additionally, 
you will be notified under the Home link of the navigation toolbar under Alerts.  
 
To sign up for interviews while logged in to your account. 
 

1. Click on Interviews in the navigation toolbar at the top of the screen. 
2. Click on the tab titled Interview Requests to view positions for which you have been selected to 

interview. 
3. Click Schedule Interview to sign-up for an interview time on the employer’s visit date. 

 

 
 

4. Select a time slot by clicking on the radio button to the left of your desired interview time. 
5. Click Submit. 
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Calendar  
 
For a detailed listing of the Company Presentations, Career Center workshops and programs, refer to 
“Employer Networking Events” or “Workshops” under the EVENTS tab.  The tabs will open all events you are 
eligible to attend.  
 
To search specific events, use the drop down menu to choose from the types of events and click Apply Search.  
Click on the link in event date to view event details. 
Click the [RSVP] to submit your reservation. 
 
You may also use the CALENDAR tab to search for events using the same steps listed above. 
 

 
 
We strongly urge you to attend all Company Presentations in which you have an interest. These sessions 
provide information on the company (it is a great way to network and gather detailed information on a specific 
organization). If an organization you are interviewing with hosts an Information Session (often the night prior to 
the interview date), it is may be mandatory for you to attend.   
 
Reminder 
Frequently check your Eagle Ops record, voice mail and email.  We may need to contact you regarding 
interviews or interview changes.  Also update your phone and email information on Eagle Ops. 
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On-Campus Interview Policies & Procedures 
 
The guidelines set forth in these documents are designed to define the roles and responsibilities of all parties 
involved in the recruitment process: Students, Employers and The Career Center staff. 
 

STUDENT RESPONSIBILITIES 

Participation in the On-Campus Interviewing program is open to the following members of the Emory community: 
undergraduate and graduate students from the Emory College and Bachelors of Business Administration students 
from the Goizueta Business School. Participation in the on-campus recruiting program is a privilege and comes with 
certain ethical expectations and responsibilities listed below. 

Eligibility. To participate in On-Campus Interviews, you must be physically present on-campus. Should you be pre-
selected and are unable to be physically present on the date and time of the interview, please contact The Career 
Center immediately and we will advocate on your behalf with the organization as to their preferred alternate 
interviewing policy. The Career Center reserves the right to remove you from the interview schedule should you fail 
to comply with the policy.  

Provide accurate information. You are responsible for providing accurate information about your academic 
background and work history, including courses taken, grades, positions held, and duties performed. However, you 
may refuse to provide an employer with specific information about any job offers you may have received from other 
employers. You do not have to provide specific information about the names of the organizations or salary. Instead 
you may give broad responses to such questions, naming types of employers industries and general salary ranges 
rather than specific salary amounts. 

Misrepresentation  
If a student falsifies a resume or an employment application/document or misrepresent him/herself to any 
employer, whether via on-campus programs or in an independent job search, the student may be subject to 
University judicial charges. The Career Center may suspend a student’s privileges to use all career services 
and programs.  Employers have the right to terminate a student’s employment or withdraw a job offer for 
misrepresentation. 

Interview genuinely. Interview only with employers you are sincerely interested in working for and whose eligibility 
requirements you meet. "Practice" interviewing is strongly discouraged, as it is both misleading and unethical. When 
you use a company as a "practice" interview you are misleading the recruiter and denying a person with a genuine 
interest the opportunity to interview. 

R.S.V.P. The term “R.S.V.P.” is from the French phrase “respondez s’il vous plait.”  R.S.V.P. simply means “Please 
reply.”  In a business situation, an associate who does not respond to an R.S.V.P not only comes across as rude, 
but unprofessional as well. 
 
Anyone receiving an invitation with an R.S.V.P. on it is obliged to reply as promptly as possible.  It is 
inexcusably rude to leave someone who has invited you to a party with no idea of how many people to 
expect.  You must respond to an R.S.V.P. whether you will or will not be attending. 

On-Campus Interview Policies. Keep all commitments for employment interviews.  If you cannot attend the 
interview due to an emergency situation, notify The Career Center at the earliest possible moment.  
 
The Career Center adheres to a Zero Tolerance Policy for students who fail to show up for a scheduled interview on 
campus. See Cancellation and No-Show Policy below for details. 
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Inform employers about your decision to accept or reject an offer in a timely fashion. Communicate your 
acceptance of refusal of a job offer to employers as promptly as possible, so they can notify other candidates that 
they are still being considered or that the position is filled. 

Claim fair reimbursement. If an employer has agreed to reimburse you for expenses you incur in its recruitment 
process, your request should be only for reasonable and legitimate expenses. 

Obtain the career information you need to make an informed choice about your future. It is your responsibility 
to look into career opportunities and the organizations that offer them, as well as acquire any other relevant 
information that might influence your decision about an employer. 
 
 
POSITION ACCEPTANCE POLICY 

Withdraw from recruiting when your job search is completed. Once a student has accepted a job offer, whether 
via on-campus recruiting or in an independent job search, or has decided that full-time graduate or professional 
studies are for you, notify the Career Center staff. You must report your Salary & Hiring information to The Career 
Center and withdraw applications and resumes to all other employers and positions to which you have applied 
immediately. You should also inform employers that are considering hiring you for a job that you no longer 
interested in the opportunity.  Adherence to these business etiquette guidelines is expected. 

Accept a job offer in good faith. Accepting a job offer is a professional commitment.  Accepting an offer only as a 
precautionary measure is misleading to the employer and may restrict opportunities for others who are genuinely 
interested in that employer.   

Reneging on an offer is a serious violation of The Career Center’s policy, and will result in immediate suspension of 
all recruiting privileges. You will be required to meet with the Associate Director of Recruiting.  Future recruiting 
privileges will be determined after this meeting.   
 
To help you in your decision, make sure you have all the information you need from the company making the offer, 
as well as from the other companies with which you interviewed.  If you find yourself in a difficult situation, please 
meet with the Associate Director of Recruiting before you make your decision.  The Career Center may be able to 
intervene on your behalf. 
 
 
INTERVIEW CANCELLATION AND NO-SHOW POLICY 
The Emory University Career Center offers students an expansive and professional Recruiting/On-Campus 
Interviewing Program.  When students fail to show up for scheduled interviews with employers, they damage the 
Recruiting Program, and the reputation of the school.  Missed interviews also jeopardize the job search of fellow 
Emory students.  Reserving a time slot and then failing to attend the interview prohibits other students from using 
that interview time slot, and significantly diminishes an alternate candidate’s chance to interview.  Such behavior 
reflects poorly on all of Emory University.  It not only wastes corporate dollars and the recruiters' time, but it can also 
cause employers to suspend recruiting at Emory University altogether.  It can also compromise Emory’s relationship 
with the employer regarding research and related activities. Therefore, it is critical when a student signs up for an 
interview that he/she follows through on the commitment.  If students are unable to keep the scheduled interview 
due to an emergency, the appropriate steps must be taken to avoid penalty.   
 
Canceling an Interview: 
 
Students may cancel an interview by removing his/her name from an interview schedule via Eagle Opportunities 
Network prior to the schedule closing.  All schedules are closed 72 hours prior to the interview date.  Once the 
schedule has closed, students are not permitted to cancel an interview or change an interview time slot via Eagle 
Opportunities Network.   
 
Once the 72-hour deadline has passed, students must call The Career Center to cancel the interview.   
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• Call The Career Center's Associate Director of Recruiting or the Recruiting Coordinator as soon as possible 
at 404-727-6211 to cancel your scheduled interview.  Please note that cancellations made within 72 hours of 
the interview date are considered unexcused absences, and students will be penalized as outlined in the 
No-Show Policy below.   

 
No-Show Policy: 

The no-show policy is designed to ensure that students meet the recruitment commitments they make through 
eRecruiting’s Eagle Opportunities Network.  If you miss an interview, you may be suspended from further 
interviewing. Depending on the reason, this suspension may be either temporary or permanent.  Students will be 
considered a “no-show” if they:  

• Cancel a scheduled interview less than 72 hours before the interview.  
• Do not show up for a scheduled interview with an employer.  

If a student violates the No-Show Policy as stated above, The Career Center will immediately inactivate the 
student’s EON account. The student will receive an email from the Recruiting Coordinator notifying them of the 
missed interview on the date of the interview. The email will contain notification of the inactivation of their account 
and instructions on resolving the no-show issue, including a copy of the Missed Interview Application Form and a 
sample Letter of Apology.  Apology letters will need to be addressed to the organization. The name and title of the 
recruiter will be provided in the email. You will need to schedule an appointment with the Associate Director of 
Recruiting and submit the following items within 48 hours of the missed interview.  Bring a Letter of Apology and 
explanation to the employer, along with a stamped envelope. After the apology is approved, The Career Center will 
mail the letter to the employer. 

Within 24 hours of meeting with the student, the Associate Director of Recruiting will send an email describing your 
no-show status. Resolution will result in one of the following: 

 No-show will be excused and noted. Access to Eagle Opportunities Network will be 
reinstated. 

 No-show will be unexcused and noted. Notification will also be sent to either the Associate 
Director of the Career Management Center at the Goizueta Business School, student’s 
coach or academic counselor. Access to Eagle Opportunities Network will be reinstated. 

 No-show will be unexcused and noted. On-Campus Interviewing privileges will be revoked 
and the student’s EON account will be terminated. Notification will also be sent to either the 
Associate Director of the Career Management Center at the Goizueta Business School, 
student’s coach or academic counselor. 

In the case of a second violation of Emory’s No-Show Policy: 

If a student fails to submit an apology letter or if a student violates the no-show policy a second time, On-Campus 
Interviewing privileges will be revoked and the student’s EON account will be terminated. Requests for 
reinstatement will be at the discretion of the Recruiting Director.   

This policy is in place to protect the students of Emory University.  No-shows jeopardize the recruiting relationship 
Emory has established with the employer, damage the university’s reputation, and deny other students an 
opportunity to secure interviews.   
 
The following actions may result in permanent loss of interviewing privileges with The Career Center:  

• Blatant disregard for policies and practices.  
• Rude and unprofessional interview behavior.  
• Failure to respond to no-show notification.  
• Failure to complete no-show policy requirements.  
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• Missing a scheduled interview a second time (receiving a second no-show notification email).  

EMPLOYERS' RESPONSIBILITIES  

Confidentiality. Employers are expected to maintain the confidentiality of student information, regardless of the 
source, including personal knowledge, written records/reports, and computer databases. An employer should not 
disclose information about a student to another organization without their prior written consent, unless necessitated 
by health and/or safety considerations. 

Accurate information. Employers are expected to provide accurate information about their organizations and 
employment opportunities. This includes, but is not limited to, positions available, responsibilities, career 
advancement opportunities, and benefits. 

Freedom from undue pressure. Employers are expected to provide students with a reasonable amount of time to 
make a decision about accepting an employment offer. The Career Center asks employers allow students at least 3 
weeks to make their decisions. They are also expected to provide the student with a reasonable process for making 
their decision. 

Timely communication. Employers are expected to inform students of their status in the hiring process and 
communicate hiring decisions within the agreed upon time frame. 

Fair treatment. If an employer is required to revoke a job offer that a student has accepted, because of changing 
conditions within the company, student is entitled to a fair and equitable course of action. That action can include but 
is not limited to, financial assistance and outplacement service. 

Testing information. Employers should inform students in advance of any testing, the purpose of the tests, and 
their policies regarding disclosure of test results. 

Nondiscrimination. Employers are expected to avoid discrimination in their recruitment activities and to follow 
equal employment opportunity and affirmative action principles. 

Reporting Salary / Hiring Information. The Career Center requests employers to inform us of all offers of 
employment that are extended to students in order to ensure that we maintain accurate statistics regarding student 
employment. Organization’s employment records are kept strictly confidential and used only for statistical purposes. 

Third Party Recruiters. In accordance with the policies of the National Association of Colleges and Employers 
Principles for Career Service Professionals, organizations providing recruiting services for a fee will be required to 
inform The Career Center of the specific employer the represent and the specific jobs for which they are recruiting, 
and will permit verification of the information. Third-party recruiters that charge fees to students will not be permitted 
access to The Career Center services. In addition, The Career Center will send resumes directly to the 
organization’s recruiter. Access to their account on eRecruiting will not be permitted. 

 


